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In Lesson 3 – Getting Around QuickBooks – QuickBooks Menu Commands  

We will devote an entire lesson to the QuickBooks Menu’s and what they contain.  Knowing how to 
get around QuickBooks and where to find certain functions will be very beneficial to you as you begin 
to use the program.

Intuit has put the most commonly used features in plain sight….on the Home Page. You are allowed 
to add to this Home Page, when you begin to setup your QuickBooks Preferences (Lesson 4), other 
functions that you will commonly use.  However, the Menu's do contain other equally as important 
though less often used functions and it is in your best interest to know where they are and what they 
are for.

Note: This is a free excerpt from QuickBooks for Contractors – Mastering QuickBooks for 
Commercial Contractors and is copyrighted property owned by Sunburst Software Solutions, 
Inc.  If you are a Certified QuickBooks ProAdvisor or CPA and wish to reprint or redistribute this 
article you will need permission to do so.  Please contact us.
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Getting Around QuickBooks – Menus
Lesson Objectives

Learn how to navigate within QuickBooks by using Menu’s

Become familiar with the contents of each Menu

Learn the location of important functions
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Getting Around QuickBooks – Menus
File Menu

1) New Company:  Used to start the EasyStep Interview to create a new company file
2) Open Company:  Used to open another QuickBooks company file
3) Open Previous Company:  Displays a list of company files opened previously
4) Close Company:  Closes the current company file without closing QuickBooks
5) Switch to Single User/Multi-user Mode:  Allows you to switch between Single and Multi-user modes.  

Some activities can only be performed in Single User Mode and logged into the QuickBooks file as the 
QuickBooks Administrator.

6) Portable Company file:  A portable company file is a compact version of your company file, small enough 
to be sent by e-mail or saved to portable media. Use a portable company file, if you have a large 
QuickBooks file (over 30 MB), whenever you need to move your company data to another location or 
send it to another person.  The portable company file is saved with a .QBM extension. When it is opened 
in the other location, it is saved as a QuickBooks company (.QBW) file.

7) Back Up:  Used to initiate the "backup" routine to safeguard your QuickBooks data against accidental loss 
due to computer viruses or failure.  Backup every day!  

8) Restore:  Used to initiate the "restore" routine of you company data in the event of a computer virus or 
failure.

9) Utilities: Provides access to utilities or tools that will allow you to import data, export data, synchronize 
contacts, verify your data, rebuild your data, cleanup your company data, and remote access.

10) Accountants Review:  The accountants review is a special QuickBooks company file that will allow you to 
send him/her a copy of your data in order to make some adjustments to  your books while you continue to 
work in the file on a day-to-day basis.  When the accountant finishes, you are able to merge the 
accountants changes into your current file.

11) Print:  This option will become active depending on where you are within the QuickBooks program 
allowing you to print certain lists.

12) Save as PDF:  This option will become active depending upon where you are within QuickBooks and will 
allow you to save certain forms (Estimates, Invoices) or Reports to .pdf format.

13) Print Forms:  This option will allow you to batch print certain forms (Invoices, checks, etc.)
14) Printer Setup:  If you have multiple printers in your office this will allow you to select specific printers to 

print certain forms with as well as change default font sizes.  
15) Send Forms:  This option is only available if you sign up for a QuickBooks Merchant Services Account 

(fee required) and wish to accept electronic payments.
16) Shipping:  Allows you to set up Fed-Ex or UPS Shipping options.
17) Exit:  Exit the QuickBooks Program.

18)NOTE:  Due to space limitations, more information will be provided in QuickBooks for Contractors –
Mastering QuickBooks for Commercial Contractors when it is published. 
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Getting Around QuickBooks – Menus
Edit Menu

The options in the QuickBooks Edit Menu will change as you start working with various forms and 
are usually self-explanatory.  Above is the basic Edit Menu that you will see if you have no forms 
open.

The most important option on the Edit Menu is the Preferences section (which allows you to tell 
QuickBooks how you do things in your company) and will be covered extensively in Lesson 4 -
Setting Up QuickBooks - Preferences.

As you begin working with various forms (Invoices, Estimates, Bills, etc) you will discover that there 
is an option to Memorize specific types of transactions.  By memorizing recurring transactions you 
can then group them and set a schedule which will then automatically post the transaction; this 
eliminates data entry.

We will discuss the benefits of Memorizing transactions in a later lesson.
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Getting Around QuickBooks – Menus
View Menu

Most of the commands under the View Menu are self explanatory. 

The Open Window List allows you to turn the Open Window List on or off to display what 
windows you currently have open in QuickBooks - I find this to be a tremendous timesaver.   To give 
you more room to work on the task at hand, QuickBooks displays one window at a time.  When you 
open a window, it appears in front of other windows that you have previously opened.  The Open 
Window List keeps track of the windows that you have open.  Use the Open Window List to switch 
between windows while you work.  To switch to another open window, just click on the title of the 
window that you want to display.

The Navigation Bar gives you easy access to the QuickBooks Centers and can be turned on or off.

You can turn the top Icon Bar on or off.

Customize Icon Bar when it's visible, you can customize it with the commands you use most 
often; more on this is Lesson 4 - Preferences.

For comparison purposes, you might wish to display more than one window at a time.  You can 
switch between viewing a single window and viewing multiple windows.  When you choose the View 
Menu and click on Multiple Windows, QuickBooks will “tile” the windows in the main area.  You can 
then move and resize them as needed.

Important Note:  When you exit QuickBooks be sure to close ALL of your open windows 
(Window Menu – Close All), otherwise the next time you open QuickBooks it will have to reload all of 
these windows and that takes time and system resources. 
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Getting Around QuickBooks – Menus
Lists Menu

The Lists Menu is a basic QuickBooks feature.  It provides easy access to lists of important 
QuickBooks information, such as your Chart of Accounts, etc.  You will fill out most QuickBooks 
forms by selecting entries from a list.  Lists save you time and help you enter your information 
consistently and correctly.

QuickBooks Lists are the backbone of the entire process of keeping your books.  Each and every 
transaction that you enter in QuickBooks will work with multiple lists in order to provide you with 
job costing and accounting functions.

You will find yourself always using these standard lists:
• Chart of Accounts
• Item List 
• Fixed Asset Item List
• Price Level List
• Billing Rate Level List
• Sales Tax Code List
• Payroll Item List
• Class List
• Other Names List
• Templates
• Memorized Transaction List

Due to space constraints important details about the Lists Menu will only be 
provided in the final book upon publishing.
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Getting Around QuickBooks – Menus
Contractor Menu

The Contractor Menu provides access to:
Job Costing Center provides an overview of your 3 most profitable jobs during the last 12 months, 
provides access to Job Costing Reports, shows if your actual costs are over or under your 
estimated costs, if you have expenses that are not assigned to jobs, and how much you have in 
outstanding bills due to vendors.
Create Estimates and Change Orders takes you to the Estimate form.
Create Invoices takes you to the Invoice form.
Receive Payments takes you to a customer payment screen where you can receive payments. 
Make Deposits takes you to a window that will list multiple checks that you have received. Create 
Purchase Orders takes you to the Purchase Order form. 
Enter Bills takes you to the enter bills form. 
Pay Bills takes you to the pay bills screen. 
Update Item Percent Complete takes you to a window where you can manually update your 
percent complete of each line item for a specific job.
Job Costing provides you with access to various Job Costing Reports.
Time/Enter Single Activity takes you to a window where you can enter time against a single
activity for a specific employee against a specific job. 
Use Weekly Timesheet takes you to a timesheet where you can choose a specific employee and 
enter his hours worked by day on all the jobs that he was working on during a single week.  
Billing Rate Level List will take you to the window where you can set custom service item rates 
for different employees and vendors.
Pay Employees takes you to the pay employees window where you can select employees that you 
wish to create paychecks for.
Pay Liabilities takes you to the pay liabilities where you can, then, cut checks for your payroll 
liabilities.
Online Services provides access to various on-line services.

Due to space constraints important details about the Contractor Menu will only be 
provided in the final book upon publishing.
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Getting Around QuickBooks – Menus
Company Menu

The Company Menu provides you with the following options:
•Home Page takes you to the QuickBooks Home Page
•Company Information allows you to enter additional information about your company, which, 
then, can be included on Estimates, Invoices, etc.
Advanced Service Administration  
•Set Up Users the QuickBooks Administrator only can add and setup additional users.
• Change Your Password all users will have the ability to change their own password, but not the 
password of anyone else.
•Planning & Budgeting here you will be able to access helpful tools to create budgets or analyze 
your business.
•To Do List I can't stress enough that you should use this tool to remind yourself of tasks that you 
wish to complete by a specific date or have others complete by a specific date. 
•Reminders another great tool that should be used in conjunction with the To Do List.
•Alerts are pre-configured reminders about depositing payroll taxes, filing tax forms, etc. and will 
also appear on the Reminders List.
•Chart of Accounts yet, another way to reach your Chart of Accounts List.
•Make Journal Entries use this option when you need to record the Journal Entries that your 
accountant provided you in order to close out a year after completing your tax return.
•Enter Vehicle Mileage QuickBooks can track mileage for your business vehicles allowing you to 
use the mileage information for tax deductions for your vehicles and to bill customers for mileage 
expenses.
•Prepare Letters with Envelopes this is another under utilized feature that most people seem 
unaware of.  Use this function for any type of correspondence that you find yourself frequently typing 
in Word; as a matter of fact, if you already have a Word "template" that you use quite often it is easily 
converted to a QuickBooks "letter".

Due to space constraints important details about the Company Menu will only be 
provided in the final book upon publishing.
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Getting Around QuickBooks – Menus
Customers Menu

The Customers Menu will provide you with easy menu access to the following items:
• Customer Center yet another way to open the Customer Center.
• Create Estimates selecting this option will open the QuickBooks Estimate form and allow you to 
"build" a schedule of values, estimate, or bid for a project using cost codes from your Item List for a 
specific Customer & Job. 
• Create Sales Orders selecting this option will open the QuickBooks Sales Order form.
• Create Invoices selecting this option will open the QuickBooks Invoice form, when you select a 
specific Customer & Job and you have an existing Estimate; QuickBooks will prompt you to create an 
Invoice from the Estimate.
• Enter Sales Receipts selecting this option will open the QuickBooks Sales Receipt form, this 
form can be customized and used for situations where you already have the check in hand (like when 
you receive a job deposit or a bank draw before you actually begin work on the project).
• Enter Statement Charges most contractors should avoid using this option.
• Create Statements this option will allow you to provide a summary of all of your transactions 
with a specific customer. 
• Assess Finance Charges this option will allow you to charge customers with overdue balances a 
late fee or finance charge.
• Receive Payments selecting this option will open the Receive Payments window where you will 
receive customer payments against invoices. 
• Create Credit Memos/Refunds selecting this option will open the QuickBooks Credit Memo 
form where you can issue a customer a credit memo or a refund. 
• Add Credit Card Processing selecting this option will launch QuickBooks internal web browser 
and display option about setting up Credit Card Processing.
• Enter Time selecting this option will provide you with two options for entering your employees 
time spent working on jobs by using either the Weekly Timesheet or to enter a Single Time Activity 
for an employee against a specific job. 
• Item List provides another way to access your Item List.
• Change Item Prices provides another way to change prices on your item list.
• *Construction Application for Payment* this is NOT a standard item on this list and is 
intended ONLY to demonstrate the ability to add a "link or shortcut" from within QuickBooks to a 
QuickBooks integrated or QuickBooks compatible application that has been developed by a third 
party. 

Due to space constraints important details about the Customer Menu will only be provided in the final 
book upon publishing.
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Getting Around QuickBooks – Menus
Vendors Menu

The Vendors Menu will provide you with easy access to the following:

Vendor Center yet another way to get to the Vendor Center.

Enter Bills selecting this option will open the Enter Bills form where you will enter bills from your 
vendors and assign the costs to applicable jobs. 

Pay Bills selecting this option will open the Pay Bills window where you can show bills that are due 
by a specific date or all outstanding bills and select the ones that you wish to pay. 

Sales Tax this menu option expands to provide you easy access to everything that is Sales Tax 
related, such as Pay Sales Tax, Adjust Sales Tax Due, or run the following reports - Sales Tax 
Liability, Sales Tax Revenue Summary and Sales Tax Code List.

Create Purchase Orders selecting this option will open the Purchase Order form where you can 
create Purchase Orders to track work that you subcontract out or to track materials that you order 
for various jobs.

Receive Items and Enter Bills this option will only be active if you choose to use Purchase 
Orders. 

Receive Items this option will only be active if you choose to use Purchase Orders. 

Enter Bill for Received Items this option will only be active if you choose to use Purchase 
Orders. 

Inventory Activities are not usually used by contractors

Print 1099s/1096 this option opens the 1099 and 1096 Wizard where you can: Review your 1099 
Vendors, Set up your 1099 Account Mapping, Run a summary report to review your 1099 data, and 
Print your 1099's and 1096 Summary on pre-printed forms.

Item List provides another way to reach your item list.

Due to space constraints important details about the Vendor Menu will only be provided in the 
final book upon publishing.
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Getting Around QuickBooks – Menus
Employees Menu

The Employees Menu will provide you with easy access to the following:
Employee Center another way to access the Employee Center.
Payroll Center another way to access the Payroll Center.
Enter Time selecting this option will allow you to enter employee time. 
Pay Employees selecting this option will take you to the Pay Employees Window where you can 
select employees that you wish to pay and begin creating paychecks.
Edit/Void Paychecks selecting this option will allow you to edit or void specific paychecks that you 
have previously issued.
Process Payroll Liabilities selecting this option provides you with access to various functions 
regarding the payment of payroll liabilities; including paying payroll taxes or paying employee 
deductions - such as, child support.
Process Payroll Forms selecting this option will allow you to process various Federal and/or 
State Payroll Tax forms depending upon which Payroll Tax Service you purchase from Intuit.  The 
Standard Payroll will allow you to process Federal tax forms while the Enhanced Service will allow 
you to process both Federal and State tax forms.
Payroll Service Activities selecting this option will allow you to: Activate Direct Deposit, Modify 
Payroll Service Options, Update Payroll Account Information, View Payroll Messages, Manage 
Service Key, or Run Payroll Checkup.
Payroll Setup selecting this option will activate the QuickBooks Payroll Setup Wizard.
Get Payroll Updates selecting this option will open the Get Payroll Updates window where you 
can see what tax table version you are currently using, when you must update your current version 
(in order to stay on top of any federal or state tax changes).
Worker's Compensation this option will only be active if you have subscribed to the Enhanced 
Payroll Service and have activated the option in the Employees Preference.
Payroll Item List another way to get to your Payroll Item List.
Billing Rate Level List another way to get to your Billing Rate Level List.
*Certified Payroll Solution* this is NOT a standard item on this list and is intended ONLY to
demonstrate the ability to add a "link or shortcut" from within QuickBooks to a QuickBooks 
integrated or QuickBooks compatible application that has been developed by a third party. 
Due to space constraints important details about the Employee Menu will only be provided in the final book upon 
publishing.
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Getting Around QuickBooks – Menus
Banking Menu

The Banking Menu will provide you with easy access to the following:

Write Checks opens the Write Checks window; usually used for recording handwritten checks.  Do 
NOT use the Write Checks window to pay bills entered in Accounts Payable or to pay Payroll 
Liabilities.

Order Checks & Envelopes provides options for ordering checks and envelopes online from 
Inuit.

Enter Credit Card Charges opens the Enter Credit Card Charges window where you can enter 
individual credit card purchases.

Use Register allows you to select and use checking or savings account registers.

Make Deposits opens the Make Deposits window and shows you a listing of all checks sent to 
Undeposited funds allowing you to group checks for making bank deposits.

Transfer Funds opens the Transfer Funds window where you can record transfers of money from 
one account to another.

Reconcile opens the Begin Reconciliation screen where you will select the account you wish to 
"balance"; choose the statement ending date, the beginning balance is always the ending balance 
from the previous statement; as well as, enter the ending balance, a standard monthly service charge, 
or interest earned for the statement period.

Online Banking selecting this option will allow you to setup online banking functions; view 
financial institutions that work with QuickBooks online banking, and learn about online bill 
payments.

Loan Manager allows you to keep track of and manage all your loans in one place; we'll be covering 
Loan Manager in detail in a later section. 

Other Names List another way to access your Other Names List.
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Getting Around QuickBooks – Menus
Reports Menu

The Reports Menu provides you with easy access to the numerous reports that QuickBooks can 
generate.

You can create almost any report you may need by selecting the correct basic report and using 
customize and filters.  You should explore the possibilities and experiment with the options.  Nothing 
you do to a report will change the underlying data.

While these reports are far better than reports offered in older versions of QuickBooks, many of 
them still stop a step or two short of the same type of reports that are offered in costly, construction-
specific software that cause you to have to run more than one report to get the information which you 
are "really" looking for.

The Contractor Reports Menu 
options allows you to select the 
following reports that are specific to 
the Premier Contractor Edition or 
Enterprise Contractor Edition.  
Many of these reports can be 
created and memorized using 
QuickBooks Pro - it's very nice to 
have all the customization and 
memorization already done for you.
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Getting Around QuickBooks – Menus
Window Menu

The Window Menu provides access to the following options:

Arrange Icons

Close All this is one of the most useful options in QuickBooks...especially, if you work in 
QuickBooks with several windows and/or reports open at the same time before you close 
QuickBooks for the day.  You will want to use this option to close all of your open windows before 
you exit.  If you do not close the open windows, the next time QuickBooks starts it has to open all of 
these windows and build the reports - causing it to be slower to load.

Tile Vertically allows you to vertically tile your open windows and/or reports.

Tile Horizontally allows you to horizontally tile your open windows and/or reports.

Cascade allows you to vertically cascade your open windows and/or reports.
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Getting Around QuickBooks – Menus
Help Menu

The Help Menu provides access to various QuickBooks Help options:
QuickBooks Help this option opens the standard QuickBooks in-program Help file where you can 
search for answers on how to do normal every-day tasks.
Contractor Help this option opens an additional QuickBooks in-program Help file that Intuit has 
added to address the construction industry.  For the most part, the information contained here is 
either very generic or geared more for builders/remodelers. 
QuickBooks Learning Center this option opens the Learning Center where you can access 
various flash tutorials on how to use QuickBooks. 
Year-End Guide this option opens a Year-End Checklist that is especially helpful for new business 
owners by providing a list of the most common tasks that should be completed at the end of the fiscal 
year. 
Access Support Resources this option displays a window that provides links to both Self-Help 
Resources, Assisted Support, and various paid support options.
Send Feedback Online this menu options allows you to send a product suggestion, submit a bug, 
or submit a suggestion for Help topics.  
Internet Connection Setup will allow you to configure your internet connection. 
Add QuickBooks Services this option opens a browser window where you can select to add 
various QuickBooks services.
Update QuickBooks this option provides access to options regarding how to update your 
QuickBooks installation. 
Manage My License this option will allow you to easily purchase additional QuickBooks licenses. 
QuickBooks Privacy Statement this option allows you to read in detail Intuit's Privacy 
Statement.
About Automatic Update this option simply tells you a little about the QuickBooks automatic 
update feature, and why they recommend that you leave it turned on.
About QuickBooks Premier : Contractor Edition 2006 this option will  open a window that 
displays your QuickBooks License number, Product Number, and how many licenses that you 
currently have for this product.
Due to space constraints important details about the Help Menu will only be provided in the 
final book upon publishing
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What’s Next?

In Lesson 4 we will review and setup QuickBooks Preferences.

By now you should understand and feel pretty confident about why you need to “keep books” for 
your company, what types of capabilities QuickBooks offers, what it’s limitations are, and have a 
good feel for how daily activities are recorded in QuickBooks using “forms” – covered in Lesson 1 –
Getting Started.

If you are a new QuickBooks user or are setting up a new QuickBooks file because your current file is 
too large or needs a lot of clean-up, you should feel pretty confident on how to go through the entire 
EasyStep Interview – covered in Lesson 2 – Setting Up QuickBooks – The EasyStep Interview.

You should feel comfortable and familiar with how to navigate through QuickBooks using the Menu’s 
and what the various options allow you to do – covered in this lesson.

In Lesson 4 – Setting Up QuickBooks – Preferences we’ll do a very thorough overview of each of the 
QuickBooks Preference options and help you to set them up to get the most out of your QuickBooks 
software.


